


Introduction 
This easy-to-use publishing program, with its word processor and 
graphics based on the popular movie Jurassic Park™, allow you 
and your children to combine art with text to create poster . or 
young users, Kid's Menus are included to make using the pro r m 
less confusing, with fewer menus and a shorter list of option. t< 
choose from. The program includes bold graphic background 
designed to be "written upon". It allows you to take advanta ol 
clip art that is easy to move and change. For a "crash cours " on 
how to use the program, go to the Quick Start section. For an in 
depth explanation of the program's many exciting features, r ~ h 
the Full Menus section or the Kid's Menu section of the Ref r n 
Guide. 

Special features include: 

• Goof-proof designing--reposition text and clip art any tim 
• Type in a variety of styles and colors 
• Flip, rotate, and resize text and clip art 
• Group clip art 
• Resize background graphics 
• Choose from Kid's Menus or Full Menus 
• Basic drawing tools 
• Import PICT, TIFF, EPS files 
• Prints in a variety of sizes up to 37 feet tall! 
• Color printing on a variety of printers, including the 

Image W titer 
• System 7 compatible 
• 2 MB free memory needed 
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Installing Jurassic Park TM on a Hard Disk 

If you're using a Macintosh with a hard drive, you'll want to install the 
program onto your hard drive. This will make the program more 
convenient to use. Because of the amount of art included with this 
program, the information on the distribution diskette has been 
compressed. To use the program, you will need to decompress the 
disk onto your hard drive. 

J. Create a new folder on your hard drive and name it Jurassic 
Park. 

2. Insert the program disk into your drive and double-click on the 
disk. When the disk icon opens up, you will see an icon in 
the disk window. 

3. Double-click on the Jurassic Park.sea icon and the Select 
Destination Folder dialog box appears. 

4. Click on the Drive (or Desktop) Button until the name of the 
hard drive appears next to "Volume:." 

5. Scroll down and double click on the Jurassic Park folder 
name you previously created in step 1. The name "Jurassic 
Park" should appear next to "Folder:". 

6. Click on the Extract Button to extract the program from the 
disk to your hard drive. When you decompress the files, they 
automatically create art folders for themselves. 

7. After the files are extracted, you are returned to your desktop. 

8. Store the master disk in a safe place. 
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Changing the Amount of Memory 
the Program Uses 

ii□- Jurassic Perk'" lnro -

Et ..h.rusic P.rk'" 
1.12 

KIM: 'P!llie,tion progr"" 

If you're running System 7 or Multifinder 
and you get an "out of memory" message 
while using the program, you can increase 
the program's memory size from the Get 
Info Window in the File Menu. 

Siu: 3:50K on dl,k (3S7 ,76, bjtts ustd) 
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1. Quit the program and then click the 

Jurassic Park icon to select it. 

,.-.,., R-w--ts---
! S~sttdstzt: 1260 K 
' ~K ! Mi'limum stzt : 

I Prtftrrtd siz:t: 2. Choose Get Info from the File 
Menu. 

0Loc .. 4 

3. Drag across the number in the box labeled "Application 
Memory Size" to select it. 

~K 

4. Type the number of kilobytes (K) of memory you want the 
program to set aside for itself. (Add 500K to the Application 
Memory Size, or more if necessary. 

5. Close the Get Info Window. 

16 Color Mode 

I 

We recommend that you use only the 16 color mode. Using the 256 
color mode slows down processing and uses up memory. 

1. To specify the number of colors to be displayed on the 
monitor, first choose Control Panel from the Apple Menu. 
The General Control Panel appears. 

2. Scroll if necessary to locate the Monitors icon, then click it 
to display the Monitors section. The Monitors Control 
Panel appears. The pointer becomes a crosshair when you 
place it in the monitor-position or monitor-characteristics 
area. 

3. Click on the Colors circle and the number 16 inside the 
Characteristics box. The number of colors you 
specified remains in effect until you change it. 
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Quick Start 

If you're already familiar with the Macintosh, this section will let you 
get right into the program and have a printout within minutes! Quick 
Start provides step-by-step instructions to create a document without 
the need to learn all of the options available in the program. Once you 
have an understanding of how to create a design with backgrounds, 
clip art, and text, we suggest that you read the Reference Guide. There 
you'll learn how to take advantage of all the special features available 
to you. 

Here are some terms that you should know before starting: 

• Click on- Use the Mouse to move the Arrow Cursor onto 
the clickable area desired and press the Mouse Button. 

• Select- Use the Mouse to move the Arrow Cursor to the area 
you wish to select and hold down the Mouse Button. Scroll 
up or down until the selection you want is Ihlffialhlllffialhlft~©l and 
then release the button. 

•Dragging-Use the Mouse to move the Arrow Cursor to the 
object you would like to move and hold down the Mouse 
Button while moving the Mouse so that the object moves or 
stretches. 
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Creating a Design 

Boot up the program 
by double-clicking on 
the Jurassic Park 
Icon. Click on the 
opening screen picture 
and a new file 
automatically opens 
up under the name of 
Untitled. You'll begin 
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creating your design, using the Kids's Menus, with a background 
picture. Select Kid's Menus from the Edit Menu. 

Background Pictures 

Select Picture from the File Menu. The first time you select art, a 
dialogue box appears with the art folder listed. 
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Double-click on the Art Folder and a list of background pictures appears. 
Highlight a background and click on Open. 

Another dialog box appears displaying a miniature representation of 
the background. You're given the choice of loading a different 
background or the one you selected. Click on Done to place the picture 
on your document. The upper portion of the background that you 
selected appears on the screen. Use the scroll bars to view the entire 
background. 
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Adding Clip Art 

Choosing a Category 

Now you're ready to add clip art. 
Select Clip Art from the File 
Menu. A list of clip art 

rJ. Folder FIie Drtu1 Option, Group 
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categories appears. Click on a clip art category. The first piece of 
clip art from that category appears in the Preview Box. Use the~ 
12.ar to preview the clip art. When you decide on a category, click on 
Open. 

Designing with Clip Art 

The first piece of clip art (from the category that you selected) appears 
on your design. Press the Space Bar to view the different pieces of 
clip art in the category. Move a piece of clip art by dragging it 
anywhere on the background. If you want another piece of clip art 
from the same category, hold down the Option Key and "drag off' a 
copy. Now, simply press the Space Bar to view the other clip art in. 
the category. Repeat these steps to continue using clip art from this 
one category. If you want to choose a different clip art category, 
select Clip Art from the File Menu. 

When you are finished placing clip art on the background, it's a good 
idea to save your design at this point. Select Save from the File Menu. 
Type in a name for your design and click on Save. The name of your 
design appears on the top of your document. 
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Adding Text 

All you need to do now is add text to your design. 
Select the Text Tool (T) from. the Tool Menu. Your 
cursor turns into a cross. Place the cursor where you 
would like to begin typing and "drag" the Mouse to 
create a text box. (Don't be concerned about the size, 
as this can be altered later. 
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Begin typing. Notice that the text box grows in size as you type.) You 
can move the text box anywhere on the screen. Select the Arrow from 
the Tool Menu and click on the text box. Notice the four grey handles 
in each comer of the text box. This indicates that the area is "live" and 
ready to be repositioned or altered. Save your design. 

Printing Your Design 

If using a LaserWriter, select Page 
Setup from the File Menu. Click on 
Options and make sure Precision Bit 
Map and Larger Print Area are se­
lected. Click on OK. If using an 
ImageWriter, choose Page Setup 
and make sure No Gaps Between 
Pages is selected; then click on OK. 

Special Note: The program will only print 
in Best and Faster. Select Faster and click on Print. 

Cancel 

Printout size: 

QSmall 

® standard 

QBlg 

O Large 

QHuge 

I DK I 

Click on OK in the Page Setup Menu. Now select Print from the 
File Menu. The Print Dialog Box appears. The default setting is 
Standard (a single page size) and is adequate for now. Click on OK to 
print your design. 

If using a LaserWriter, a second Print Dialog Box appears giving 
you all sorts of options. Ignore them. Just click on Print. That's it, 
you're done! 

There are many more exciting features available to you. Please read 
the Reference Guide for further information. 

Note: The exact content of the dialog box depends on the printer being used. 
Refer to your Macintosh owner's guide or printer manual. If your design doesn't 
print, you may not be properly linked to your printer. See the Print section of 
the Reference Guide for help. 
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---Reference Guide ---

Full Menus 
The Full Menus offer you all of the options that Jurassic Parlt Poster 
Kit has to off er. If Full Menu appears under the Edit Menu, select it. 
Otherwise, you are already in the Full Menus setup. 

The S Menu 

If you select the I Menu, there will be two items belonging to the 
program: About Jurassic Park ... and Help with .... 

Choosing About Jurassic Park ... displays an opening screen. Click 
on the picture to close the category. 

Choosing Help with ... pops-up a dialog box that lists the topics for 
which help is available. Click on Done when finished. 

File Edit Tool 

About 
Help With ... 

Onlln• Help M11nu11l 

A11gn ObJetls 
BockgnuM Polterns 
e11ckgr-oun<1 Picture 
!hckground Lio111r 
Clip Art 
Color 
De\1te 
Duplic11te 
Group 
Importing Art & Text 
Movino Art 

Gu 

Importing Art on the Scrapbook 

0 USI ll'lls onlln• h1lp facility, tQ 
Just click on the topic you wish 
lo look et, end it's hr:!lp teMl will 
eppeer 1n this winllow 

Any image that can be saved 'into the Scrapbook can be imported and 
used in your Jurassic Park designs. 
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Edit Tool P11ttern The File Menu 
Op11n,,. 

Clip Art ... 
Place Background 

................................ __ 
Close 
S,ll'H 

Saue es ... 
................................................. __ 

Print Preulew 
Poge Setup ... 

New- Select New to open a blank page 
(Shortcut, X N). If there is a file open already, 
New will be grayed out. Only one file can be 
open at one time. You'll have to close the 
opened file by selecting Close from the File 
Menu. 

Pnnt ~P .............................................. Open- The Open command allows you to 
,__o_u_n _____ ~_o;.J open different files, using a standard 

Macintosh-style list box. Select Open from 
the File Menu. Highlight the file name that you want and click on 
Open. Your document appears. If you're already in the program and 
want to open another file, save and close the file you're in first 
(Shortcut, XO). 

Clip Art 

Select Clip Art to access 
the clip art categories. 
(If this is the first time 
you are accessing art 
files since booting the 

d';,. Folder FIi ■ Drtue Options Group 

0 Apetoseunu 
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:,:: [ Desktop ] 

::::: 
::~:; I\ Open J 
~ - • 181 Pre11lew on [ Cancel ] 

program, a menu will appear displaying the Art folder. Click on Open.) 
Highlight a clip art category and the first piece of art in that category is 
displayed in the Preview Box. Use the scroll bar to preview the clip 
art. If you want the clip art category, click on Open and you 're returned 
to your design. The first piece of clip art in the category is on the 
screen. Press the Space Bar or the Right Arrow Key to view all the 
clip art within the category. (To view the clip art in reverse order, 
press the Shift Key before pressing the Space Bar or press the Left 
Arrow Key.) If you want to add an additional piece of clip art from 
the same category, select Duplicate from the Edit Menu, XD, or hold 
down the Option Key. If you want to add another piece of clip art 
from a different category, select Clip Art from the File Menu. 
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Deleting Clip Art- Click on a piece of clip art and press the Delete 
Key. 

Place Backgroud: 

Frame- Select Frame from the Place Background Submenu. (If this 
is the first time you are accesing art files since booting the program, a 
menu will appear displaying the Art Folder. Click on Open). Highlight 
Frame and click on Open and a list of frames appears in the Preview 
Box, Click on Select to add the frame to your document. The frame 
borders the entire page. 

Pattern- Background patterns are =::.::~:~:-~·~• .. ,.., □ 
designed with individual pieces of ,_ ..... "·· 

ui..eet1ntt•-· 

clip art. Select Pattern from the :=::::::-~: 
Place Background Submenu. (If :=::::::~: 
this is the first time you are accessing '------""" CE I c- .. , 1 ~ aft fj} • b • th Patten stya.: 0 Sleg9erell ,•tt•r11 0 .. ,der P•tlem 

1 es since ooung e program, a ®Co .. ..-,,atte,. Qllledpattun QCHia10,atta,_ 

menu will appear displaying the Art 
fol~er. Click on Open). A list of clip art categories appears. Highlight 
a chp art category and the first piece of clip art appears in the Preview 
Box. Click on Open. The Background Pattern Design dialog box 
appears. Each piece of clip art is named and displayed in a list. 
Highlight the name of the piece of clip art you want to create a pattern 
with. Click on the various Radio Buttons to view the different patterns. 
Select a Pattern Style: Corners pattern, Staggered pattern, TIied 
pattern, Border pattern, and Custom pattern. Click on Done and 
the pattern covers the background. (The default pattern is the comer 
pattern as represented on the right.) Select Custom Pattern to design 
your own pattern. Within the window displaying your pattern, 
consecutive clicks removes or replaces each piece of clip art in the 
pattern. When you finish, clic~ on Done. The pattern appears on your 
background. The individual pieces of clip art that make up a 
background pattern can be edited. • Select Background Layer from 
the Edit Menu and click on the piece of clip art that you want to edit. 
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Picture- Select Picture from the Place Background Sub menu to place 
a background picture on your document. (If this is the first time you 
are accessing art files since booting the program, a menu will appear 
displaying the Art folder. Click on Open). Highlight a background 
and click on Open and the Position and Size dialog box appears. The 
background picture you choose can be scaled, resized, or moved. You 
can either type in the scaling percentages, or you can do it freehand by 
clicking on Resize Graphic and dragging the comers of the picture in 
the Preview Box. Clicking on the Move Graphic ''Hand'' repositions 
your background on the page. Clicking on Load Graphic allows you 
to choose a different picture without going back to the Menu Bar. 
Clicking on Done places the background picture on your document. 

Close- The Close command closes the document on your work screen 
without exiting from the program. If you have made changes since 
you last saved, the program gives you an opportunity to save again 
before closing. 
(Shortcut, XW) 

Save- The Save command saves your design to disk. If you haven't 
named it yet, then you have to enter a name at the prompt. Save it 
either on your hard drive or on a floppy disk. (Shortcut, XS) 

Use the Save command early and often. Develop the habit of saving your work 
while thinking about what to do next. 

Save as ... - The Save As ... command lets 
you save your document under a new name 
without replacing your original. 

Click on Options in the Save As dialog 
box if you plan on exporting your file. This 
allows you to select a File Format, 
Scanning, and Filter options. 

~ 
~ 
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File Formats- There are 
three file formats: BBM, Pict2, 
and Tiff. Selecting BBM 
allows you to edit your file with 
Street Fighter only. Pict2 
allows you to edit your file with 

m 

1 rne Fonneh: 1 QQ 
L-~-•e_M ___ O_P_ICT_2 _O_TI_FF _ ___, ( Ct::el ) 

'----~ 

FIiters:-------~ 

® Floyd-51elnberg 
QStucti 
O Burkes 

O Sierra 
O Jaruis, Judice, & Ninke 
O steuenson t Arce 

different paint and page layout programs. Tiff (Tag Image File Format) 
allows you to edit your files using most scanner manufacturers and 
page layout programs. 

Scanning- The Serpentine Option causes the dither routines to scan 
in a zig-zag motion as opposed to the right to left motion. This affects 
the appearance of dithering. 

Filters- If you want to save a color design to a B & W Pict file, you 
have to dither it so the color transforms into B & W patterns. Use the 
filter options to introduce the desired dithering effects to your design. 
Click on the "Dither Output" check box in the Print Menu. Select 
a filter from the "Filters" pop-up menu. The filters are diffusion 
methods, named after the mathematicians who invented them, that 
diffuse color into B & W patterns. Floyd-Steinberg, the default filter, 
produces the best overall quality. 

If the dithered output is too light or too dark, you can adjust the 
brightness of the filter to improve the quality. There is also a "Coloring 
Book" filter (only works on color art) which removes all color from 
the document except black. This produces art that can be colored by 
hand. When done, click on OK. 

Helpful Hint: When printing a dithered picture to a laser printer, turn off the 
"Graphics Smoothing" option in the Page Setup Dialog Box. This prevents the 
printer from distorting the dithered patterns in the output. "Larger PrintArea" and 
"Precision Bitmap Alignment" found in the Options section of the Page Setup 
Dialog Box should be turned on to allow the full page to be printed. 

Print Preview- Select Print Preview to see a miniature representation 
of your entire document on the screen at one time. Clicking anywhere 
returns you to your document. 
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Page Setup ... - When you choose Page Setup, the Page Setup Dialog 
Box (belonging to the printer you currently selected) appears. 

Print- Select Print to bring up the Print 
Size Dialog Box (Shortcut, 3€P). 

The program can print your design at 
100% on one sheet of paper, or it can 
scale the document up or down from 1 % 
all the way up to 4500% (2025 sheets of 
paper). 

Width Inches: 8.0" 

Height Inches: 11.0· 

Width Pages: I 

Height Pages: I 

Total Pages: 1 

!Olt 111 ■111 ■111 ■1H■ll¢1 

SteNng ~ • I 00 

~ I OK I 

Note: It is advantageous to print any document that will be la,ger than one sheet of 
paper on an Image Writer as opposed to the IAserWriter. The IAserWriter prints 
individual pages and leaves a border around your design, so that when you piece 
together the pages you will have to trim them. 

Printing One Strip at a Time 

When printing something larger than the Standard size, you may want 
to print only part of it at one time. In the Print Menu, select "from" in 
the Pages section and type in which pages you want printed. 

/ ' 
at 100% 

Width inches: 80' 
Height inches: 100' 
Width pages: 1 
Height Pages: 
Total pages: 

'- ~ 

For example. at t 00% takes up a 8 x to· piece of paper 

at800% 
Width inches: 64' 
Height inches: 80' 
Width pages: 8 
Height Pages: 8 
Total pages: 64 

If you can print at 800%, then it will be 64" wide and 
80" high. Your print dialog box will show that at 800% 
your printout will be 8 pages high, with a total of 64 
pages of paper used 

Consequently, you have 8 vertical sections, and you can print out each 
of these vertical sections separately. In the dialog box, type in from 1 
to 8 for the first section. Then type in from pages 9-16. Subsequent 
sections would be 17-24 for the third section, 25-32 for the fourth 
section, and so on. 

If you 're using Postscript fonts and a Postscript printer you can type in point sizes 
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other than those listed and still print out snwoth-edged letters (though they will look 
jagged on the screen). If you're using True Type with a compatible printer; both the 
print on your screen and your printed output should look smooth. The same will be 
the case if you're using a display rasterizer like Adobe Type Manager. 

Using a LaserWriter™ Printer 

To print with a LaserWriter, first go to Page Setup and select all of the 
Printer Effects. 

.;;,;L•;.;,;••;.;.;rW;;,;.r;.;.;ll•;.;.r;..;Poa,.;ge;..;S,;.;•t.;,:;up"--------7'-'.,-CJD 
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Enlarge: L:::J 
Orientation 
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Printer Effects: 
181 ront Substitution? 
181 TeNI Smoothlng1 
181 Grophlu Smoolhlng1 
181 roater lllmop Prlntlng1 

Then click on the Options Button and select Precision Bitmap 
Alignment and Larger Print Area. 

LeserWrlter Options 1.1 OE::J 

E] 
D flip Horlzontol { Cancel ) 
□ mp uerllcal 
D ln11ert Image 
C83 Precision lltrn1p Alignment (4'J. reduction) 
181 Larger Print Rr111 (Fewer Downloadable fonts) 
D Unllm1ted Downloadable fonts in a Document 

Click OK when you've selected all of the options that you want. Click 
OK again in the Page Setup Dialog Box. Then select Print from 
your File Menu. Your Print Size Dialog Box appears. 

Click OK after you've selected a size and the Print Dialog Box appears. 
On the bottom of the dialog box, six filters are featured. 

Scanning is for the method of printing, and it is for you to decide what 
works best. The Serpentine Option causes the dither routines to scan 
in a back and forth motion. Select other choices you need and click on 
Print. 
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If you have a color monitor that is set to t 6 or more 
colors, your print Dialog box will look like this. 

LeserUJr1ter "'Spot The Wonder Printer" 1.1 c:EE:) 
Copliu:1111] Pegaa: ® All O from: D To: D ( Cancel ] 
Couer- Page: ® No O first Page O Last Page ~ 
Peper Source: ® Peper Ce1 ■ette O Manuel Feed 
Print: O Bleck & White ® Color/Greyaule 
Destination: @ Printer O Po1tScripte File 

If you are working on a black and white monitor or 
a color monitor set to black and white, your print 
dialog box will look like this 

B & W Laser Writer users: Select Color\Grayscale for best results. 

Using an ImageWriter™ 
Printer 
When printing on an ImageWriter, 
select Page Setup from the File 

.:.:'-::1ra:::w;:.:a'"a:."-------U..ZR- OD f'•per: • us htl•r O 14 latler 
O us L•1.. O lnlernlionol hnf•ld 
O Computer, .. .,. 

Df1Nt•tlon Specie! Hflch: 0 , .... d .... tad 
■ ~ 050 ~ Rad1Ktt.n l!!!!fl D ~ ,.,, letweea P•te• 

Menu. Choose the US Letter paper size if you are using standard 
fanfold computer paper. Always select No Gaps Between Pages from 
Special Effects. Then click on OK and select Print from the File 
Menu. 

If you are working on a B & W monitor or a color monitor set in the 
B & W mode, your Print Dialog box will look like this. 

"'tma..a•&.a¥•aa.W""'rlt""'•r _________ ... zp- GED 
Ouolity: O BHt ® Fester O Draft 
Pege Range: @ All O From: D To: D ( C1nnl } 
Coples: 111!!!!1] 
Poper Feed: @ Automatic 0 Hond Feed 

If your monitor is set at 16 colors, your Print Dialog Box will look like 
this. 

.;,;;tm.;;;.•Y""'•"'Wr""il.;;;.er __________ a..__ GED 
ouollly: O IHI ® rutor O Droll 
Pege Range: ® RU O From: D To: D ( Cancel ) 
Coples: LJ 
Poper Feed: ® Rutomellc O Hond Food 

O Dither output ['FIiters:: I 
Scennlng:.=l •) floHd *S1<~1nhcqJ O Sl•~rrn 
® lcf1 1u Fll!Jh1 0 Stud:, 0 ,IMl•h. Judi<•~.,, "'-Ink<, 
Q SC!lllell0JH? L.._Q:_D_u1_ke_., __ ---=-Q_St_e1_1e1_1"_'"-" _llr_1:e _ _, 

O lmegeWrlter with color ribbon 
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To print in color, be sure you have a multi-colored ribbon set in your 
printer. Choose the print quality you want (Draft is the fastest). Then 
choose Image Writer with color ribbon. Choose Page Range when 
you are printing a large creation and you only want to print a section of 
it. When all settings are correct, click on Print. 

Note: The exact content of the dialog box depends on the printer being used. Refer 
to your Macintosh owner's guide or printer manual for other printer options. 

Warning To Network Users: When using the Jurassic Park network version on a 
network, you won't be able to print in color on an Appletalk /magewriter Instead, 
you must print on an Imagewriter that's di'fl?ctly connected to your computer. 

Quit- Select Quit to close your current document and exit from the 
program. If you have made changes since the last time you saved, the 
program will ask "Save changes before quitting?" (Shortcut, XQ). 

The Edit Menu 

Undo- Undo can often be used to 
cancel your last action. If the choice 
is dimmed, then Undo is not 
available for that particular 
operation (Shortcut, XZ). 

Cut- Select Cut to cut out a selected 
(active) area of text or clip art to put 
onto the Macintosh Clipboard. 

1Jn1l1> 

i:ut 
[llfll,l 
Push~ 
[ ll1nr 

>i(<2 

:)[:f) 

Back round la er XB 

Show Clipboard 
Preferences ... 
Kid's Menus 

Background Frame 
Background Pattern 
Background Picture 
All Shapes 

The object can then be pasted into another document or the Macintosh 
Scrapbook (Shortcut, XX). 

Copy- Select Copy to place a copy of the selected text or clip art onto 
the Macintosh Clipboard wi~hout disturbing the selected object 
(Shortcut, XC). 
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Paste- Select Paste to place a copy of whatever is on the Macintosh 
Clipboardinto your document. The object stays on the clipboard and 
can be pasted as many times as desired (Shortcut, XV). 

Graphics and text can be imported into Street Fighter™ via the Macintosh Clipboard 
or Scrapbook. Simply paste it into your document. When the graphic is pasted in, it 
can be scaled, squeezed, squashed, or stamped! 

Clear- Unlike Cut, the Clear command removes the selected object 
or text without placing it on the clipboard. Anything that's "cleared" is 
gone forever. It's a menu version of the Delete Key. 

Duplicate- The Duplicate command is one of the most 
useful tools for creating designs. Duplicate creates a 
copy of the selected object and offsets it slightly to make 
it easier to separate from the original. Anything that 

• can be selected can be duplicated. The latest copy of 
the object is automatically the ·one selected. Pressing 

the Option Key while dragging the object has the same effect. 
(Shortcut, XD) 

Background Layer- When you choose Background Layer, objects 
not on that layer are cleared away so you can manipulate the background 
pattern. Objects placed on the background layer (clip art and text) 
can't be altered while you're working in the foreground. To return to 
the foreground, select Foreground Layer (Shortcut, XB) from the 
Edit Menu. 

Remove- Objects that can't be selected would be difficult to remove, 
if no special allowance were made. Select Remove to delete patterns, 
shapes, and background pictures--items that are otherwise difficult 
or impossible to get rid of. 

Background Pattern- Select this to remove .Q!lU'.. the pattern from your 
document. 
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Background Picture- Select this to remove .Q!lU'.. your background 
picture from your document. 

All Shapes- This command removes all graphics and text from your 
document, but leaves background pictures, frames, and patterns intact. 
Choosing All Shapes is a convenient way of clearing your document. 
The All Shapes command can be set (in the Preferences Dialog Box) 
to clear both background and foreground layers, or to clear only the 
layer currently being worked on. 

Show Clipboard- Select Show Clipboard to check the contents of 
the Clipboard before taking any further action. 

Preferences ... - Certain features of the 
program can be customized to suit 
your needs. Experiment freely with 
various choices, because you can 
always reset your preferences. 

Note: Preferences take effect immediately. 
There is no need to exit the program or to 
reboot your Macintosh. 

User Preference Settings: 

HflindAwlng: 
® tool remelns selected 
O arrow becomH Hlectad 

R11moue ell •h•P•• wilt delete: 
® •II shapes I• current layer 
O ell shepH I• both layers 

Clip art ,,er.:--~ 
181 Clip ert should retain 

tren1forms during dip ert 
scrolling 

After drawing: This box determines whether the tool you're working 
with (line, star, oval, etc.) remains selected or becomes the arrow pointer· 
when you release the Mouse Button. If you need to manipulate each 
object after pasting or creating it, you might find it convenient to have 
the Arrow Tool selected for you automatically. If you're creating a 
number of objects or making objects out of separate pieces, you'll 
probably find it more convenient to have the tool remain selected. 

Remove all shapes will dele_te: This box lets you choose whether you 
want the Remove All Shapes command to wipe out everything or 
only the shapes on the current layer. 
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Clip art prefs: If you alter the dimensions of a piece of clip art, you 
can keep the alteration (squeeze, stretch, etc.) while paging through 
the rest of the clip art category. 

Draw new shapes: This box lets you choose the default setting for the 
object's opacity property. You can choose to have the new object 
transparent or you can choose the reverse. 

Drag a shape: Multiple shapes drag quicker as an outline, beca~se 
dragging an outline uses up less computing power. However, the outlrne 
is a box surrounding the objects and not the actual shape. If you need 
to judge the effect of your dragging, then you have to pause a moment 
with the object clicked on to allow time for the objects to materialize. 

Kid's Menus- Select this to switch to the limited, easy-to-use menus. 

The Tool Menu 

Clicking on any of the boxes within the Tool 
Menu selects the tool pictured there. Double­
clicking on some tools produces additional 
action. 

fL"I~ 
........_DO 
0 ( c:? 
6-QO 
Tu◊ 

The Tool Menu is actually a "tear-off' palette. Highlight the Tool 
Menu and then drag down past the end of the menu. It tears off the 
Menu Bar and becomes a palette that you can move over the surf ace 
of your document. When you tear-off the palette, you can double­
click on the tools for more options! 

The Tool Palette can be moved around by 
"grabbing" the Title Bar (clicking and 
dragging). This is useful for moving the 
palette when it gets in the way of your work. 

When you're ready to put away the Tool 
Palette, click on the close box. The palette 
disappears. 

Closm• box T;tl. Bar 

0 
'-
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rn The "Zapper" removes objects similar to the Delete Key Zapping is the 
V quickest way to get rid of an object, but once the object is zapped, its 

gone. (If you change your mind about a zapping bef01e making any other 
moves, select Undo from the Edit Menu.) 

Note: Double clicking on the 'Zapper erases your document. You'll be warned 
before this happens. 

W The Arrow is used to point to objects for a variety of reasons: 

Selecting- Use the Arrow Tool to point to an object (text, clip art, or 
shapes). Clicking selects that object for whatever action you take 
next. The Arrow also can select a group of objects. Point to a place 
above and to the left of the objects you wish to select. Then drag 
downward and diagonally so the dotted rectangle surrounds the 
objects. When you release the Mouse Button, gray handles appear 
around each object indicating that all of the objects in the group have 
been selected. A "group select" lets you perform an action on many 
different objects at the same time. This feature is ideal for saving 
created combinations of clip art and text as a single piece of clip art 
in your scrapbook, moving as a group, or performing edit functions 
and transform functions as a group. Click away from the group and 
the items respond individually. 

* * * 
Note: If you want to create a group select, but other objects a,e mixed in with the 
items you want to group, you can select just the objects that you want to gvup. 
Hold down the Shift Key and select each object. All of the selected objects can then 
be grouped. In the sample to the right, only the stars have been selected and will 
act as a group. The other shapes have !1Q1. been selected and therefore will not be 
affected. 
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• • Resizing- The Arrow is also used to resize objects by 

* pointing and dragging. When an object is selected, four 
gray handles appear. Pointing to one of these handles and 

• \ dragging causes the object to grow in the direction you're 
To resize dragging. The same method is used to reshape text boxes. 

Note that when you drag a text box, the type in the box doesn't change 
size; the box simply changes its shape. 

Note: "Grouped" objects can't be dragged to resize; however, you can use features 
offered under the Transform menu. 

Moving- To move a selected object, point to it and drag. 

Wait until the handles appear befol! attempting to drag any object. 
On complex documents, and particularly when you're working with 
color, there is a lag in selecting and in dragging. 

The Grabber moves your work 
.1fl"h screen around on the page, 
\ I similar to the scroll bars. The 

screen you're looking at is actually a 
window on a larger page. The little grabber "- ,.. 
hand "slides" the page back and forth '--' 
under the window so you can work on different parts of the page. (The 
window itself doesn't move.) Double-clicking on the Grabber has no 
effect 

, ........_ I The Line Tool draws a straight line starting at the point where 
'-- you press down on the Mouse Button and ending where you 

release it. This action is similar to stretching a rubber band 
between two points. 

Hint: To draw a perfect line (no jags), move the Mouse~ while holding the 
Mouse Button down until you reach a point where the line appears straight. 

------------------- JUIIASS/C PAII.K POSTEii. K" 

Line Description Dialog Box 

Double-clicking on the Line Tool brings up a 
dialog box that lets you choose line thickness. 
Click on the thickness and the pattern you 
would like to use. The look of the lines you 
draw is determined by the pattern selected. 

Solid--
Pattern 'l//_,,.,,.,,,,.,,,,,,,,,,,,,, 

f✓.P"~ Triangle wifh _p ,,. 
Jr \ border pattern ~,,,,,,,,,~ 

Select the line width 
end pa Item that you 
wish to use. 

i>II 111111 

+ 
jConcotlQD 

ED 

The Pattern Palette in the Line Dialog Box also affects the borders 
(or lines) that make up the other shapes you may draw, as you can see 
from the triangle above. By using the Line Pattern Palette in combi­
nation with the regular Pattern Palette, you can create a variety of 
effects. 

Solid border A 
Interior pattern a& 

Patterned border A_ 
Patterned Interior ~ 

Asymmetrical border 
Patterned Interior 

White border 
Patterned Interior i 

0 
When you look closely at the line width @111 11 

selector bars, you'll see that there are two + 
little black triangles above and below. 

91111 Ii II 

+ 0 These can be moved individually to create 
asymmetrical lines (by clicking at the top or 
bottom of the desired width bar.) 9TI 1111 II 

The circles to the right show the effect of lines that + 
are thicker in one or the other direction. The various 

0 
choices can all be combined to produce complex shapes and effects. 

fnl The Rectangle Tool creates boxes and squares by dragging, 
~ starting at the point where you press down on the Mouse 

Button and ending where you release it. The Rectangle 
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Tool draws an outline box with the currently selected border pattern 
and color. 

Double-clicking on the 
Rectangle Tool causes it 
to draw boxes filled with 
the currently selected 
pattern and color. 

Perfect squa. res are □ created by holding 
down the Shift Key 
while dragging. 

[Q] The Rounded Rectangle Tool draws boxes with rounded 
comers. Other than the rounded comers, it's identical to the 
plain Rectangle Tool. Double­

clicking on the Rounded Rectangle Tool 
causes it to draw boxes filled with the 
currently selected pattern and color. 

The Oval Tool draws ovals of 
various shapes, controlled by 
the vertical and horizontal 

distance between where you start dragging 
and where you release the Mouse Button. 

s,.,,,.,. 0 
+ End point 

Perfect circles are created by holding down the Shift Key while 
dragging. 

r:=7 The Arc Tool creates a quarter of an oval, starting where you L.CJ begin dragging and ending where you release the Mouse 
Button. The shape of the arc is controlled by the vertical and 

horizontal distance between where you start dragging and where you 
release the Mouse Button. 

Sta.I~ 

Fini,h \ 

If you drag to the right and down, the inside of the curve will face to 
the left and down. Dragging to the right and up puts the inside of the 
curve up and to the left. Dragging to the left and down puts the inside 
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of the curve down and to the right. Dragging to the left and up puts 
the inside of the curve up and to the right. 

Double-clicking on the Arc Tool causes it to draw arcs filled with the 
currently selected pattern and color. 

It's usually easier to create your arcs first, then to position them on the page. CuNes 
can often be rotated or flipped to create the contour you have in mind. 

The Freehand Shape Tool allows you to draw enclosed 
C? shapes. If you don't close your shape, the program will 

draw a straight line across the endpoints of your drawing. 
If you have selected a fill pattern, it'll be contained by the straight 
line. 

Double-clicking on the Freehand Shape Tool causes it to draw shapes 
filled with the currently selected pattern and color. 

Shapes can be drawn with no border by selecting "O" line width in theline Width 
Dialog Box. 

The Triangle, Hexagon, Pentagon, 
Star, and Diamond Tools let you draw these various shapes, 
controlled by the vertical and horizontal distance between where you 
start dragging and where you release the Mouse Button. 

Double-clicking on these tools causes them to draw shapes filled with 
the currently selected patter~ and color. 

*• . 
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r,,::::;i The Text Tool creates a box with a flashing cursor for entering 
L!_J text of your choice. Double-clicking on the Text Tool pops 

up the Text Selection Dialog Box. 

When you select the Text Tool from the Tool Palette, your cursor 
changes to a small crosshair. To begin entering text, place the crosshair 
where you would like the text box to be and drag a box out to the size 
you desire. You can start typing now, or you can pre-select a font, 
point size, and style. 

![5'~-;;-'i-;;;;-;;-"Y 060 ut ti,;;""·J; .. ;;,h··;r-·j 
hh• box It will grow downward j 

La• .. you.typ• ....... -..... ! 

Select the Arrow Tool to reshape your text box or to move it. Point to 
the middle of the box and drag to move the entire box. To resize the 
box, click on the text and drag the handles. 

JNotice that the .i.yj; d~·;·;~\;;p:~·;;_;-~;;;·;;~·~ ..... 
/resize the text box It just hne wraps ot 

idiff•r•nt points, odjustl"9 to th. ""w lino 

\l•nsth,. ·-- ................................... ·-·-· ............. . 

!Notice that t~ typo j 
!doesn't grow when j 
!vou re size the text ! 
ibo><. h j us! lino wraps i 
!ot different points, f 

jodiusting to tht-new j 
jline .. l•ngth, ........................... ...! 

Text Attributes- Fonts, point sizes, and styles can be selected either 
by choosing one attribute at a time from the menus, or by using the 
Text Selection Dialog Box which can be reached by either double­
clicking on the Text Tool or by selecting Other from the Text Menu. 

Color Type 

Zie~ ~: :~~:~:::b:~e~f a~::;~~~i~;;~~~~: 1
1 
.................................................................... 1 

click on a color in the Color Palette located under the Color Menu. 
Your text appears in the color you selected. You can also create color 
type by highlighting the text with the I-Beam Cursor and clicking on 
a color from the Color Palette. 
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The Pattern Menu 

Click on any of the boxes within the Pattern 
Menu to select the pattern pictured. Double­
clicking on the Pattern Boxes has no effect. 

The Pattern Menu is actually a "tear-off' 
palette. If you highlight the menu and drag 
down past the end, the menu will tear off from 
the Menu Bar and will become a more 
accessible palette that floats over the surface 
of your page. 

The menu The ·tear off' palene 

The Pattern Palette can be moved from place to place by "grabbing" 
the Title Bar ( clicking and dragging). When you're ready to put away 
the Pattern Palette, click on the Close Box. 

0,, • block 8. whit• 
,:,d•m 

16 Color 
256 Colo, 

The Color Menu 

Shapes- When creating 
shapes, you can assign colors 
to them. Click on a color 
from the Color Menu and 
then create your shape. 

Text-Type your text as you normally would. When you are finished, 
highlight the text and click on a color in the Color Menu. The text 
appears in the color you selected. 

Color Text on Black & White Systems- On black & white systems, 
the choices on the color palette refer to color printing rather than to 
colors displayed on your screen. If your printer can take advantage of 
the eight-color quickdraw built into black & white Macs, you can use 
this palette to assign colors to text. 

After you have typed text, highlight it with the Text Tool and click on 
the desired output color. Because you won't see the results on your 
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black & white screen, you may want to jot down your color assignments. 
(If you choose white, you'll notice a difference; the text will seem to 
vanish. If you click on the area, however, you will see the little gray 
handles belonging to the invisible text.) 

16 vs. 256 Colors 

All of Toucan's desktop publishing/print programs include art drawn 
in 16 colors. If you're not planning on importing 256 color mode art, 
then we suggest you use the 16 color mode. Using the program in the 
16 color mode speeds processing, especially in the slower color systems 
and uses less memory. 

The Transform Menu 

Transparent/Opaque ... - Objects can either cover 
whatever they're in front of or allow objects behind them 
to show through. When placing text near a piece of clip 
art or another section of text, you should select 
Transparent so that the white margin around your block 
of text does not overlap other objects. 

Font TeNI 
Transparent 

✓Dpnqua 

rllp Horlzon1111 xH 
Flip Uertlcal XT 
Rotate Left XL 
Aotete Right XR 
Custom Rotate .. . 
Scale Selection .. . 
Remoue Transforms 

Send Beck •-
Bring Fonuard X• 
Send to Beet 
Bring to Front 

All~Jn Ohj<H ts,.. :;;:M 
G1ou11 

If you create a colored object and place a text box over ,__u_,,,_,rn_•P __ "_,•u 

it, the actual text will show up with a white margin ~~:: ;~::::: 
around it. Select Transparent under the Transform 

Shortcuts... XK 

Menu to make the white margin disappear. The Transparent and 
Opaque commands can be used in combination with the Bring 
Forward and the Send Back commands to produce interesting effects. 

b•qqill .d MD::> tx.T 
•rh ot •mo::>l.W !oot 
!bl ,ow n nle eni~ ool 

Flip Horizontal- Choose Flip Horizontal to make a 
mirror image of the selected object. (Shortcut: XH) 
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m 
The Flip Horizontal command is particularly useful for creating sets 
of facing shapes. 

M 
Flip Vertical- Select Flip Vertical to turn the 

• selected object upside down. Combining horizontal 
and vertical flips can create interesting patterns. 

1i1111: (Shortcut: XT) 

~ 

0D111tr.E!!J-i. 

Rotate Left/Rotate Right- Select Rotate to tum the selected 
object 90 degrees clockwise or counterclockwise. 
(Shortcuts, XL, XR) 

u~rtkll 

Custom Rotate ... - Choose Custom Rotate to open 
the Rotation Dialog Box. The Rotate Object section 
lets you type in the number of degrees that you want 
the object to rotate and in which direction. The Radio 
Buttons in the Rotate around section determine the 
pivot around which the object swings. 

Scale Selection ... - Select Scale Selection to 
open a dialog box that lets you scale the 
currently selected object up or down in precise 
increments. Choose the same scaling 
percentage in both directions to increase or 

decrease the size of the object proportionately. 

Remove Transforms- Select Remove Transforms to cancel any flips, 
rotations, or scaling you have done on the currently selected object. 
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Send Back/Bring Forward- Each object (shape, text box, 
or piece of clip art) lies on its own layer in your document. 
You can shuffle the position of an object by sending it 
back in the stack (X-), or by bringing it forward (X=). 
When you shuffle objects, you'll often want to adjust 
whether they're transparent or opaque. 

Send to Back/Bring to Front- Choose Send to Back or Bring to 
Front to send the currently selected object all the way to the bottom or 
all the way to the top layer. 

Align Objects ... - To align a set of objects, 
you must first select them. Use the 
Arrow Tool to drag a selection box 
around them. In this example, five 
separate text boxes are being selected: 

When you release the Mouse Button, all 
of the handles appear at once. 

Now that your objects are selected, you 

i ' 
' ' ' ' ' ' ' ' ' 

A sampl. t•>d boJ11 A u1mpl. t.>Ct box 
A tamp!. 1•>1 box 

A iampl. t•>Ct box 
A sa mp!. fud box 

o I 

' ------------------------------- ---·~ 

• • 

can choose Align Objects from the Transform Menu. The Alignment 
Dialog Box appears. 

Selecting Left Sides, left justifies clip art 
or text. If you have adjusted your objects 
before selecting them, Centers will center 
objects, and Right Sides will align the 
objects flush right. The example below 
involves left justified type. 

lllgn Objeds 

-H•ri1:.nt11I eltgmnenl - -111wtitel 11Ugmnent -

SI Na tlllange a N• thHge 
O left sides O Tep, 
0 Ce ■ten O [Niten 
Q flight lklH Q lattDffil 

The vertical spacing can then be sorted out one line at a time. You 
must click on a spot away from the objects to unselect the group. Then 
click on the individual objects and adjust their vertical position. 
(Remember, pressing the Shift Key while dragging with the arrow limits 
the movement to either horizontal or vertical, depending on the direction 
of your first Mouse movement.) 
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To make your left, center, and right alignments come out properly, you should make 
sure that each text box in the g10up is individually set for the alignment you want the 
whole group to have: left for left, center for centered, right for right. 

Align Objects can also be used to line up objects vertically. 

Group- Select Group to combine all selected objects (clip art and 
text) into one main selection which can be moved and transformed 
simultaneously. 

UnGroup- Select UnGroup to undo the Group command on a 
selection of objects. This allows all objects to be moved or transformed 
separately. 

Text Props ... - Choose this to access the Text Selection Dialog Box so 
that you can set your font and point size. You can also access the Text 
Selection by double-clicking on the Text Tool on the Tool Box. 

Line Props ... - Choose this to access the Line Selection Dialog Box 
so that you can set your line size and pattern. You can also access this 
by double-clicking the Line Tool on the Tool Box. 

Shortcuts ... - Select Shortcuts to access the list of quick-key 
commands. 

-Do\ble Click 
ShQct~:uts 

~ 
Erase document 

Select 11ne ..,1dth 
When ..,ork1ng ..,ith ,elected clip art-

~} Select font type, style, 1nd ,1ze 

or uJ➔ V1e.., next c11p ort on 1ny dr,._.i n9 tool toggle, fill mode 
,h1pe When ..,ork1n9 ..,1th selection, -

or llitJ 
~ Drag ~ Con,tr11ned movement 

!Spmlls~} 
~ & Click - Multiple selection 

Vie'W previou, clt p U]~ Dr19 - Resize Text box or {i3 ert ,hepe 
!0,,1;,nl Dreg - Dup11cete Object 
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The Font Menu 

The Font Menu lets you select a font by highlighting your 
choice and releasing the Mouse Button. If you have more 
fonts installed in your system than can be displayed at one 
time, a small black triangle will appear at the end of the 
list. Dragging past the end causes the list to scroll. High­
light a font and release the Mouse Button to select. 

The Text Menu 

The Text Menu lets you select attributes by highlighting them and 
releasing the Mouse Button. 

Go to the Text Menu, click on the top of the menu, hold your Mouse 
Button down and drag, and your menu choices are available: 

✓PlalnTIHI .. , .. 
11,Hr. 

llnW1lnt 
IDlllll'IID 
~ 
Cmdense 
[Ht•nd 

✓Align Left 
Align Middle 
Align Righi 

9 point 
DIii 
011 

.;O,O 

011 
114) 
3ti 
48 
72 
Other ... 

Type Styles: 
·PlaiD-The quick brown fox jumped over the lazy dogs. 
Bold-Tbe quick 1,ro,... (ox jumped over tbe lazy dogs. 
Italic- The quick brown fox jumped over the lazy dogs. 
Underline- The quick brown fox jumped over lhe lazy dogs 
Outline - The quick brown fox jumped over the lazy dog,. 
Shadow-Tho 'l11ict brown fox j1llll~d over tho i•ZJ dog,. 
OutliH/Sbadow-Tb• 'l•ick "brow■ (0:1 jump .. ov• tbe luy clog,. 
Condeme-This compresses the amount of space between letters in your text. 
Extend-This incre;ues the amount of space between letters in your text. 

Text alignment: 
·Align Left- This changes text so that all lines are justified on the left side. 
Align Middle- This changes text so that all lines are centered with respect to each other. 
Align Right- This changes text so that all lines are justified on the right side . 
Type point size- This allows you to change the size of the text. 
Other- This allows you to create any customized size not listed in the menu. 

[fyou are choosing rrwre than one attribute, you'll.find it easier to use 
the Text Selection Dialog Box. Only one choice can be made from the 
pull-down menu before having to pull the menu down again. 
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Using the Text Selection Dialog Box 
Double-click on the Text Tool to bring up 
the Text Selection Dialog Box. It provides 
a convenient way of choosing text attributes 
all at once, instead of one at a time from the 
menus. 

1111'1• 
QSokl 
01t•lk 
□ 1n•1r11n1 
OtuUIH 
Qlh141a, 
OtlHl•enH 
Q(11n• 
Jlffltft 
·L•fl 
QCHllr 
Ollfht 

ININIIIOt11 
IIIIU 
., .. tr..,. 
eoihnllltlr 
lo41ntUUr1 
lodlll.l~ ... 
to1k,... 
Cell'9rll9htll■-er 

m 
~ :f:2 GJ 

:: ~ 
24 112:1: 

EJ 
Cl!Mnll..... b 
Chk•t• 
Coh111li.ck!"'rs 

All styles, except Plain Text, can be used alone or in combination. 
Choosing Plain Text deselects all other styles. Only one of the 
alignment and the point size options can be selected at one time. 
Choosing Other ... brings up the Text Selection Dialog Box. 

Choices under Style can be used singly or in combination; that's why 
they are presented as check boxes. 

Choices under Justify are selected singly for aligning your text. 

The Font List Box shows whatever fonts are currently listed, while 
the Point Size List Box shows which point sizes are available for 
display on screen. You can insert your own size in the size box. You 
can see the effest of each of your choices in the preview window in 
the lower right comer. 

Quick Tip: While in the text editing mode, you can rrwve the current text box you 're 
editing by holding the Command and Option Key down, and then dragging the text 
box with the A"ow Cursor. 

Kid's Menus 

The Kid's Menus are simpler versions of the Full Menus. With less 
menus and options to choose from, children will find it less confusing 
to create their own documents. 

The S Menu 
If you select the S Menu, there will be two items belonging to the 
program: About Jurassic Park ... and Help with .... Choosing About 
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Jurassic Park ... displays an opening screen showing you what version 
of the program you are using. Click on the picture to close the category. 
Choosing Help with ... pops-up a dialog box that lists the topics for 
which help is available. Click on Done when finished. 

The File Menu 

New- Select New to open a blank page (Shortcut, XN). 
If there is a file open already, New will be grayed out. 
Only one file can be open at one time. You'll have to 
close the opened file by selecting Close from the File 
Menu. 

N<~lll :•:N 
lllllifL.. :•:O 
Clip Rrt XR 
Picture 
rrnme 

Close XW 
S,Jlle :•:\ 
Print XP 

Quit XQ 

Open ... - The Open command allows you to open different files, using 
a standard Macintosh-style list box. Select Open from the File Menu. 
Highlight the file name that you want and click on Open. Your 
document appears. If you're already in the program and want to open 
another file, save and close the file you're in first (Shortcut, XO). 

Clip Art .. - Select Clip Art from the ,; ,_, "" '"" .,.,, .. ,, .• 
File Menu. (If this is the first time 
you are accessing art files since 
booting the program, a menu will 
appear displaying the Art folder. Click 
on Open). A list of clip art categories 
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appears. Highlight a clip art category and the first piece of art in that 
category is displayed in the Preview Box. Use the scroll bar to preview 
the clip art. Click on Open and the first piece of clip art from the 
category appears on your design. Press the Space Bar or the Right 
Arrow Key to view all the clip art within the category. (To view the 
clip art in reverse order, press the Shift Key before pressing the Space 
Bar or press the Left Arrow Key.) If you want to add an additional 
piece of clip art from the same category, hold down the Option Key 
and drag off a copy from the original. If you want to add another piece 
of clip art from a different category, select Clip Art from the File 
Menu. 
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Deleting Clip Art- Click on a piece of clip art and press the Delete 
Key. 

Picture- Select Picture from the File Menu to place a background 
picture on your document. (If this is the first time you are 
accessing art files since booting the program, a menu will appear 
with the Art folder in it. Click on Open). A list of backround 
pictures appears. Highlight a background and click on Open and 
the Picture Preview dialog box appears. The background picture 
you chose appears in a viewer box to the left. Clicking on Load 
Picture allows you to choose a different picture without going back 
to the Menu Bar. Clicking on Done places the background picture 
on your document. 

Frame- Select Frame from the File Menu to place a frame on your 
document. (If this is the first time you are accessing art files since 
booting the program, a menu will appear with the Art folder in it. 
Click on Open). Highlight Frames and click on Open and a list of 
frames appears. Highlight a frame and it appears in the preview box. 
Click on Select to place the frame on your document. 

Close- The Close command closes the document on your work screen 
without exiting from the program. If you have made changes since 
you last saved, the program gives you an opportunity to save again 
before closing (Shortcut, XW). 

Save- The Save command saves your design to disk. If you haven't 
named it yet, then you have to enter a name at the prompt. Save your 
document either on your hard drive or on a floppy disk 
(Shortcut, XS). 

Use the Save command early and-often. Develop the habit of saving your work 
while thinking about what to do next. 
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Print- Select Print to bring up the Print Size Dialog 
Box (Shortcut, XP). Select a size and click on OK. 
See the "Print" section in the Full Menus section 
(pages 10-12) for more information. 
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Quit- Select Quit to close your current document and exit from the 
program. If you have made changes since the last time you saYM, the 
program will ask "Save changes before quitting?" (Shortcut, XQ). 

The Edit Menu 

Undo- Undo can often be used to cancel your last 
action. If the choice is dimmed, then Undo is not 
available for that particular operation (Shortcut, XZ). 

Cut- Select Cut to cut out a selected (active) area of 
text or clip art to put onto the Macintosh Clipboard. 
The object can then be pasted into another document 
or the Macintosh Scrapbook (Shortcut, XX). 

Undo X2 

Cut XH 
Copy XC 
Paste XU 
Clear 

Full Menus 

Copy- Select Copy to place a copy of the selected text or clip art onto 
the Macintosh Clipboard without disturbing the selected object 
(Shortcut, XC). 

Paste- Select Paste to place a ~ of whatever is on the Macintosh 
Clipboard into your document. The object stays on the clipboard 
and can be pasted as many times as desired (Shortcut, XV). 

Graphics and text can be imported into Street Fighter via the Macintosh 
Clipboard or Scrapbook. Simply paste it into your document. When 
the graphic is pasted in, it can be scaled, squeezed, squashed, or 
stamped! 
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Clear- Unlike Cut, the Clear command removes the selected object 
or text without placing it on the clipboard. Anything that's "cleared" 
is gone forever. It's a menu version of the Delete Key. 

Full Menus- Select this to switch to the full-featured menus. 

The Tool Menu 

Clicking on any of the boxes within the Tool Menu selects 
the tool pictured there. Double-clicking on some tools ~-­
produces additional action. See "Tool Menu" in the Full 
Menus section (pagesl6-20) for more information. 

The Pattern Menu 

Click on a filled shape that you have created. Then click 
on any of the boxes within the Pattern Menu to fill the 
shape with the pattern selected. 

The Color Menu 

To make a selection from the Color Menu, select the Color Menu and 
drag it off of the Menu Bar. 

BLACK 
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On a black & whit~ 
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16 Color 
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Shapes-When creating shapes, you can assign colors to them. Click 
on a color from the Color Menu and then create your shape. 

Text-Type your text as you normally would. When you are finished, 
highlight the text and click on a color in the Color Menu. The text 
appears in the color you selected. 

The Text Menu 

The Text Menu lets you select attributes by 
highlighting them and releasing the Mouse 
Button. 

Go to the Text Menu, click on the top of the 
menu, hold your Mouse Button down and drag, 
and your menu choices are available. 

The Font Menu 
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The Font Menu lets you select a font by highlighting 
your choice and releasing the Mouse Button. If 
you have more fonts installed in your system than 
can be displayed at one time, a small black triangle 
will appear at the end of the list. Dragging past the 
end causes the list to scroll. Highlight a font and 
release the Mouse Button to select. 
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90 DAY LIMITED WARRANTY 
Hi Tech Entertainment (formerly Hi Tech Expressions) 
warrants the physical media (CD or disk(s)) furnished by Hi 
Tech Entertainment to be free from defects in material and 
workmanship under normal use for a period of 90 days 
from the date of delivery to the original purchaser as 
evidenced by a copy of the purchase receipt. Hi Tech 
Entertainment will replace any such defective media which 
I promptly returned to it free of charge. 

The foregoing warranty is in lieu of all other warranties 
xpressed or implied, including but not limited to the 

Implied warranties of merchantability and fitness for a 
p rticular purpose. In no event will Hi Tech Entertainment 
b liable for special or consequential damages even if Hi 

ch Entertainment has been advised of the possibility of 
uch damages. 

TECHNICAL SUPPORT 

If you are having difficulty installing or using the program 
II Hi Tech Entertainments' Technical Support Staff at 1-

00-216-1750 during these times: 

Monday to Friday, 9:00 AM to 5:00 PM EST 

No game playing hints will be given by the Hi Tech 
ntertainment technical support staff. 

Please do not return your software unless you receive an 
uthorization number from a support technician. 

JURASSIC PARK TM & 10 1994 Universal City Studios, Inc. & Amblin Entertainment 
Inc. All Rights Reserved. Licensed by MCA/Universal Merchandising, Inc. Published by 
Hi Tech Entertainment, 584 Broadway, New York, NY 10012. 
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Hi Tech Entertainment 
584 Broadway, New York, NY 10012 

212-941-1224 


